
Student Guide to Take-Home Exams 

Instructors at the Earle Mack School of Law have the option of giving their final exams in the traditional in-class 

format or in take-home format.  While in-class exams typically make use of the Securexam Student software, 

take-home exams require only a web browser (Internet Explorer, Firefox, or Safari) and Microsoft Word.  While 

no special software is needed, there are some specific instructions that must be followed to insure that you are 

able to access and complete your take-home exam and submit it for grading.   

 General Information about Take-Home Exams 

 Download Your Exam – Log in to the PlanetSSI website and download the exam question(s). 

 Complete Your Exam – Answer the exam questions in Microsoft Word. 

 Prepare Your Exam For Uploading – Remove your non-anonymous information from the exam response, 

insert your anonymous exam ID, and save it in an appropriate format. 

 Upload Your Exam – Log in to PlanetSSI and upload your file to the appropriate class. 

 Check Your Exam Status – See exactly when you downloaded or uploaded an exam. 

 Troubleshooting Tips and Getting Help – If you have problems with any of the above, check here first. 

General Information about Take-Home Exams 

There are a few significant differences between in-class and take-home exams.  Specifically: 

 You do not use Securexam Student for take-home exams; you’ll type your exam answer into Microsoft 

Word.  Since Word lacks the integrated anonymity features of Securexam Student, you need to take 

specific steps to ensure that all personally-identifiable information (other than your exam ID) is 

removed from your document before uploading it to PlanetSSI.  See Prepare Your Document For 

Uploading for specific instructions. 

o NOTE: While you are not specifically required to use MS Word, you are required to save your 

document in MS Word format before you submit it.  Also, we can only provide specific 

instructions and support for MS Word. 

 Pay close attention to the time limit.  The clock begins ticking the moment you download the exam 

questions from PlanetSSI.  If your instructor has specified an 8-hour limit, and you downloaded the exam 

at 8:00 AM, you must upload it by 4:00 PM to avoid having it marked “Late”.  See Check Your Exam 

Status for details on how to view your exam download & upload times. 

 You will need internet access only to download the exam questions and upload your responses.  Be sure 

that you will be in a location with a reliable connection for both of these processes.   

 Most students will outline their response or create multiple versions of the document as they refine and 

edit their answers.  Please make sure that you select the appropriate (final) version of your response 

when you upload it.  The Prepare Your Document For Uploading section contains specific suggestions on 

how to name and save the final version of the document to minimize possible problems. 

 Even though take-home exams are not proctored, you are still bound by the conditions of the Code of 

Conduct and any specific restrictions or requirements set forth by your professor in the exam 

instructions that they provide. 

http://www.drexel.edu/law/PDFs/Code-of-Conduct-08-19-08-Policy.pdf
http://www.drexel.edu/law/PDFs/Code-of-Conduct-08-19-08-Policy.pdf


 

Download Your Exam 

1. Log into Planet SSI at www.planetssi.com with your username and password.  Your username is your 

Drexel e-mail address (example: abc123@drexel.edu) and your password is your 5-digit anonymous 

exam ID (example: 12345).   

 

2. Once you have logged in, you will be taken to a console page.  Click on Exam Center in the left-hand 

pane.  

 
 

3. Click on the Download button to the right of the name of the exam to download your take-home exam 

questions (in PDF format).  As soon as you click on the Download button, the time limit will begin to 

elapse.   

 

NOTE:  If you’re using Internet Explorer, the integrated “download blocker” may prevent the file from 

downloading.  In this event, you should see the Internet Explorer “Information Bar” appear just below 

the address bar.  If this happens, click on the Information Bar and then click “Download File”. 

http://www.planetssi.com/
mailto:jw123@drexel.edu


 

4. You should then see a “File Download” dialog box: 

 
5. Click “Save”.  You will then see the “Save As” dialog.  You can save the file to either the “Desktop” or the 

“My Documents” folder; just remember where you saved it so you’ll be able to find it later! 

 

6. Once you’ve downloaded your exam file, you must logout of the Planet SSI website by clicking the 

“logout” icon (circled in red below).  Failing to do so may lead to problems uploading your exam later!! 

 

 

Complete Your Exam 

As stated earlier, you’ll use Microsoft Word to complete your take-home exam.  You all know how to use 

Microsoft Word, so we won’t get into that right here, but there is one thing you need to do to insure that the 

grade for your exam is properly credited to you.  You need to insert your Anonymous Exam ID in the document.  

To avoid problems, you must put your exam ID, along with the name of the course and the instructor, into the 

“header” of the document so that it appears on each page.  Please use the following format: 



Exam ID: insert your 5-digit exam ID here, e.g.: 12345 

Class Name: insert the name of the class, e.g.: Con Law II 

Instructor Name: insert the instructor’s name, e.g.: Prof. Jones 

Most of you have had to use the header or footer in Word before (e.g., to insert page numbers), so you may 

already know how to do this.  If not, see the instructions below for your version of Microsoft Word. 

In Word 2003 for Windows: 
1. Click the “View” menu  
2. Click “Header and Footer” 
3. Enter the appropriate information in the “Header” field at the top of the page 
4. In the “Header and Footer” toolbar, click “Close” 
 

In Word 2007 for Windows: 

1. Click “Insert” at the top of the window to open the Insert tab in the ribbon 

2. Click the “Header” icon and then click “Blank”  

3. Enter the appropriate information in the “Header” field at the top of the page 

4. Click “Close Header and Footer” at the far right end of the ribbon 
 

 In Word 2004 for Mac OS:  
1. Click the “View” menu  
2. Click “Header and Footer” 
3. Enter the appropriate information in the “Header” field at the top of the page 
4. In the “Header and Footer” toolbar, click “Close” 

 
 In Word 2008 for Mac OS: 

1. Click the “View” menu  
2. Click “Header and Footer” 
3. Enter the appropriate information in the “Header” field at the top of the page 
4. Click “Close” below the header 

Prepare Your Exam For Uploading 

Before uploading, to ensure anonymity, you must remove your personal information from your exam file before 

uploading it.   

 In Word 2003 for Windows: 
1. Open your document in Word 2003. 
2. Click “Tools.” 
3. Click “Options.” 
4. Click on the “Security” tab towards the top of the box. 
5. Under “Privacy options,” check the box next to “Remove personal information from file properties on 

save.” 
6. Save your file and close it before uploading it. 

  
 In Word 2007 for Windows: 

1. Open your file in Word 2007 and click on the "Office" button in the upper left-hand corner. 
2. Select “Prepare,” then “Inspect Document.” 



3. If prompted to save the document before inspection, click “Yes.” 
4. Uncheck the box next to “Headers, Footers, and Watermarks”. 
5. Click the “Inspect” button. 
6. On the next screen, click any “Remove All” buttons that appear. 
7. As a final check, click the “Reinspect” button. 
8. Repeat steps 4-6 until no more items are found. 
9. Click the “Close” button in the Document Inspector window. 
10. Save your file and close it before uploading it. 

 
 In Word 2004 for Mac OS:  

1. When in your file, click the “Word” menu near the top right corner of the screen. 
2. Click on “Preferences.” 
3. Click on the “Security” tab on the side. 
4. Check the box that says “Remove personal information from this file on save.” 
5. Click on “OK.”  
6. Save your file and close it before uploading it. 

 
 In Word 2008 for Mac OS: 

1. When in your file, Click the “Word” menu in the upper left corner of the screen 
2. Click on “Preferences” 
3. Click on “Security” under “Personal Settings” at the bottom of the window 
4. Check the box next to “Remove personal information from this file on save” 
5. Click “OK” 
6. Save your file and close it before uploading it. 

 
Finally, to avoid confusion when you have to select a file to upload, you should name the final version something 
unique.  Click the File menu (or the Office button, if you have Office 2007) and click “Save As…” and then name 
the document something short and easily recognizable, like “Con Law Exam – FINAL”.  This is extremely 
important because when you’re browsing for the file you want to upload, you may see only a shortened version 
of the name (e.g., instead of “Con Law Exam Winter 2007.doc”, you might see “Con Law Ex~.doc” or “Con Law 
Ex…”).  Also, save it somewhere that you’ll be able to find it easily, such as your Desktop or My Documents 
folder.    

Upload Your Exam 

1. Before the end of the prescribed time period, log into PlanetSSI at www.planetssi.com to upload your 

exam file (in Word 2003 format).   

2. Click on Exam Center in the left-hand pane. 

3. Click the Upload button (1) to the right of the exam, then click Browse or Choose File (2) to open the 

“Choose File” dialog: 

1  

 

2  

 

http://www.planetssi.com/


 

4. Navigate to the location where your completed exam file is located, then click the file and click “Open.”  

5. Finally, click the Upload button (1, shown above)   

6. A dialog box will appear confirming that the file was successfully uploaded and within a few minutes, 

you should receive an email from support@softwaresecure.com as further confirmation – it’s a good 

idea to save that at least until the exams have been graded in the event you need to provide “proof of 

submission”.  If you don’t get a confirmation message, see Check Your Exam Status below. 

Check Your Exam Status 

You can use the “Reports” tool in Planet SSI to see when you actually downloaded or uploaded an exam or to 

simply confirm that your exam has been correctly uploaded.   

1. Click on Reports in the left-hand pane: 

 

2. Under “Additional Search Criteria,” select Non-Securexam as the Securexam Type.  

 

                            
 

3. Leave all other search fields blank and click the Search button at the bottom of the screen. 

4. In the “Download Exam”(1) column, you will see the date and time when you downloaded the exam. 

5. In the “Upload Exam”(2) column, you will see the date and time when you uploaded the exam (if you 

have not already uploaded the exam, this field will be blank). 

 

1 2 



Troubleshooting Tips and Getting Help 

Assuming the instructions shown above are followed completely and carefully, you should not run into any 

issues with your exam.  However, in the event that you do have a problem, please consult the information below 

before contacting any Law School staff for assistance. 

Question/Problem: “I can’t log in to Planet SSI…what should I do??” 

Answer/Solution: The username and password you need to use for the Planet SSI website are the same as those 

you use for Securexam.  That is, the username is the “short” form of your Drexel e-mail address – this is your 

initials followed by 2 or more numbers and ending with “@drexel.edu” (for example: “ck76@drexel.edu” is 

correct, just “ck76” is not correct).  The password is your 5-digit Anonymous Exam ID for the current term.  If 

you don’t know what your 5-digit Anonymous Exam ID is, you can retrieve it by logging into Bb Vista at 

http://learning.drexel.edu and going into the Law School’s Virtual Community.  Once you’re in the Virtual 

Community, click on the “My Grades” link on the left side of the page.  The (Quarter) Exam ID: is what you 

need (e.g., Quarter=“Fall 2009-10”, “Winter 2009-10”, etc.) 

Question/Problem: “I go to the ‘Exam Center’, but I don’t see my class listed!” 

Answer/Solution: The class lists were entered into Planet SSI just a few weeks ago and should be complete and 

accurate.  Therefore, you should see your correct classes listed, but if you do not, please contact the Law 

School Exam Team (see below for contact info) with your Drexel username (the first part of your “short” e-

mail address, described above) and the name(s) of the class(es) which are not appearing.   

Question/Problem: “I’m trying to download my exam, but when I click ‘Download’, nothing happens!” 

Answer/Solution: This can happen if you’re using Windows XP or Vista and Internet Explorer 6 or newer.  There 

is an integrated “download blocker” which prevents the automatic download of potentially dangerous files.  

When you try to download something and this blocker is activated, you should see the Internet Explorer 

“information bar” appear below the Address bar in the Internet Explorer window.  It will look something like 

this: 

If you see this, click on the information bar and a small menu will appear.  Click on “Download File” in the 

menu, then click Save and choose a location to save the file.   

Question/Problem: “I’ve downloaded the exam file, but can’t open it!” 

Answer/Solution: All of the exam question files are in Adobe PDF format, so you need  to use the Adobe Reader 

to open them.  If you do not have this installed, you can download it free from 

http://learning.drexel.edu/


http://www.adobe.com/products/acrobat/readstep2.html.  Once you’ve installed Adobe Reader, you should 

have no trouble opening your exam file. 

Question/Problem: “I uploaded my exam, but didn’t see the confirmation dialog or get an e-mail” 

Answer/Solution: First, click on “Reports” in the Planet SSI website to, select “Non-Securexam” next to 

“Securexam type:” and click Search.  If your file was successfully uploaded, you’ll see the date & time of the 

upload in the “Upload Exam” column.  If there is a date & time there (and it matches the date & time that 

your uploaded your exam), but you haven’t gotten the confirmation e-mail, it may just be delayed.  

Remember, too, that this confirmation message is sent to your Drexel e-mail address, so be sure that you’re 

looking there.  If you forward that mail to another account or address, the chances of “delayed delivery” are 

much greater.   

If the “Upload Exam” field is blank, then the file was not uploaded successfully.  In that case, try uploading it 

again, and remember that the upload process is a bit repetitive.  You need to click “Upload”, then “Browse” 

or “Choose File” to select the file to upload, then click “Upload” again.  If the dialog box did not appear, it 

may have been blocked by a popup blocker.  The blocker built into Internet Explorer will not block it, but 

some others might.  Unfortunately, there are so many different blockers out there that it’s impossible to 

document all of them.  As a general rule, most popup blockers can be bypassed by pressing (and holding) the 

control key while clicking the “Upload” button (the 2nd time you click it, when the dialog box should appear).  

Again, check the “Reports” area again to verify that it was uploaded.  If it still doesn’t show up, then contact 

the Law SchoolExam Team for assistance. 

Question/Problem: “I’m still having problems!  How do I get help?” 

Answer/Solution: During normal exam hours (8:00 AM – 5:00 PM Weekdays throughout the exam period), 

Lawtech staff will be available via e-mail and phone.  You can send an e-mail to lawtech@drexel.edu or call 

Theresa Gallo at (215)571-4716. Theresa will contact technical support staff as necessary. 

 

Outside of normal exam hours, you must send an e-mail to lawtech@drexel.edu with a detailed description 

of your problem and your full contact information (name, e-mail address and a phone number where you 

can be reached).  If you are having a problem uploading your completed exam file, you must also attach 

your completed exam file to the message.  One of the Lawtech staff will contact you as soon as possible to 

assist.  Please note that we cannot make any specific guarantees regarding response times or availability 

outside of the normal exam hours (8:00 AM – 5:00 PM Weekdays throughout the exam period).  Please take 

this into account when planning to take your exam. 

Lawtech Staff Rm. 108 215-571-4800 lawtech@drexel.edu 

Theresa Gallo Rm. 450 215-571-4716 tg337@drexel.edu 

Mark Toth Rm. 450 215-571-4795 Mark.toth@drexel.edu 

 

http://www.adobe.com/products/acrobat/readstep2.html
lawtech@drexel.edu
lawtech@drexel.edu

